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Course Planning using OCAD    
By Ken Thompson on behalf of Orienteering SA 

 updated 8th Dec 2019  Feedback & suggestions to cartography@ihug.com.au                          

   

Please be Aware: Although these notes were originally prepared for OCAD 9 they 

are equally usable for later versions as well as the CS variations. The only significant difference is that in 

later versions the various menu items are located slightly differently under Course Setting, Map or 

Background Map. Other improvements in later versions include: 

 More detailed course statistics 

 Automatic adjustment of size of class box in OCAD 11 onwards 

 Ability to save back to earlier versions.  
 

A1]  BEFORE STARTING 

1. Load the map file and note the scale as in A2 7 below. The map scale and the scale in the course-

planning project need to be the same. 
2. As a course planner you need to be aware of the limitation of the type 5 SI cards we are currently 

using in SA. They keep a reserve place for the clear, start and finish but can only store 30 control 

records. Another 6 will be recorded as visiting but no time recorded.  Allowing for mis-punches that 

also count no more than 27-28 controls should be used in any one course.  

 

A 2]  GETTING STARTED 

 

The main file in a course-setting project is a special OCAD map file. Like other map files it has the 

extension .ocd, but it has a special internal mark to identify it as a course setting file. To create such a file, 

you must create a new map file. This is the only way to start a course-setting project. 

1. Choose New from the File menu or click the New button. The New Map dialog box is displayed. 

2. In the Map type box select "Course setting for orienteering". 

3. In the box Load symbols from select  “Course setting 10000.ocd or one of the other options depending 

on the actual scale of the map. 

4. Click OK. 

5. Choose Save from the File menu or click the Save button. A file dialog box appears. Enter a file name 

for the course-setting file. 

6. Choose Scales from the Options menu. Set the map scale to the correct value. This is only necessary 

when map scale is not as in 3 above. [The actual map scale can be checked by loading the map separately 

and looking at scales in the options menu]  This is important for calculating the length of the course. It also 

ensures the control circles, start & finish symbols are the correct size. 

7. Choose Open from the Background maps menu. A file dialog box appears. Select the map file for the 

project. . If the map does not seem to be visible press the whole map button (looks like a magnifying glass & 

it should appear.  In some cases you may have to load another template as well.(e.g. photographs or multi 

layered maps. You only need to do all this once. If you load the course setting file again it will remember all 

this!  

8. Choose course options from course menu to choose appropriate options for the event. 

9. Choose colours from the symbol or map (later  versions menu. Purple and Transparent Purple should 

be C35, M85,Y0, K0. (new IOF standard) This ensures that controls & course lines are visible to colour 

blind persons.  

 

B]   ADDING START, CONTROLS AND FINISH 

 

Start 

1. Select the Start symbol in the symbol box. 

2. Select any drawing mode. 

3. Click in the drawing area to place the object. 

Now the Course Object dialog box appears. It proposes the code S1 for the start. 

4. Click OK. 
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On the right side of the screen you find now a line for a text description and a line for a symbolic 

description. 

5. If required enter a text description or a symbolic description. 

 

Control 

You create a control in the same way as the start object.  

Select the Control symbol in the symbol box. 

Here you should always enter either a text or a symbolic description or both. 

 

Finish 

You create the finish in the same way as the start object.  

Select the Finish symbol in the symbol box.  

But you cannot enter a description. The appearance of the finish in the symbolic control descriptions is 

determined by the marked route from the last control to the finish. 
 

C]   ADDING A MARKED ROUTE 

On most events you have a marked route from the last control to the Finish. Sometimes you may also have 

marked between controls (to cross bridges, dangerous areas etc.). 

The description here applies to marked routes that the runner must use. If you want to add a marked route 

just for information, but which is not part of the course you have to add it as other object. 

To create a marked route: 

1. Select the marked route  in the symbol box.  

2. Select a drawing tool (e.g. the straight line tool) 

3. Draw the marked route from the last control to the finish (in the direction in which the competitors are 

running). 

4. Now the Course Object dialog box appears automatically. If the course object dialog box does not appear 

automatically, you must make a modification for the marked route symbol. See below. 

5. Click OK. 

This marked route is used for rendering the description of the finish in the control descriptions. If you check 

"Funnel tapes", then the symbol for funnel tapes will appear in the symbolic description. 

 

You may also use marked routes anywhere in the course, but note that they must be drawn in the direction in 

which the competitors are running; otherwise the course will not be drawn correctly. 

Important: Marked routes must be added to each course like controls and finish. 

 

If the Course Object dialog box does not appear automatically 

 

1. Right-click on the Marked route symbol in symbol box. 

2. From the context menu select Edit. The Line Symbol dialog box appears. 

3. In the Main line page activate Course setting symbol: Marked route. 

4. Click OK. 

Important Note: Marked routes must be added to each course like controls and finish. 

 

D]   ADDING CONTROL DESCRIPTIONS TO THE MAP 

To print a control description together with the course you have to place a control description object. This 

object is a placeholder and marks the upper left corner of the control description. 

1. Select the control description symbol (second row down) in the symbol box.    

2. Select any drawing mode. 

3. Place an object to mark the upper left corner of the control description. 

4. The Course Object dialog box appears. You can leave the preset values unchanged and click OK. 

5. If you want a text description, activate Text description in the course-setting panel on the right side of the 

screen. 

If the background map should be masked below the text description, activate the option White 

background in Options from the Course menu.  
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E]  CREATING A NEW COURSE 

Defining the name and other settings 

1. Select Courses in course menu. 

2. Click the Add button. 

3. Enter a number only in the course field and enter the remaining settings for the course. Usually you only 

need to go back to this later and enter climb when you have worked it out. 

4. Close the dialog box with the OK button. 

 

Adding course objects 

In the next step you add the course objects. They must have been created before. 

Add start, controls and finish. To add an object double-click it in the objects list in the course-setting box or 

double-click the object on the map. When you have added an object, the length of the course is calculated 

and displayed in the course setting box. 

 

Preview course: At any stage you can press the preview button to see what the printed version will look 

like. 

 

Editing the course 

 Inserting controls. In the list of the controls you find a horizontal blue insertion line. If you double 
click an object it will be inserted below this line.  

 Deleting a control from a course. Select (left click) a control in the control list of the course. Press 
the Delete key to delete the selected control for the course.  

. 

Adding relay variations 

In relays you have often variations.  

OCAD supports 2 kinds of variations: 

Team variations: These are the commonly used relay variations. Runners of different teams go to different 

controls. The lengths of the legs are approximately equal. 

Leg variations: These variations are used for special cases. Example: In a relay for teams with 3 runners, the 

third runners have a longer course than the first and second runners. In this case somewhere in the course the 

third runners go to another control than the first and second runners. 

 

To add a variation you must have specified a relay course in the Courses dialog box in the menu Course. 

Select the Relay in the Course type field and close the dialog with OK. 

1. Click in-between the corresponding controls to set the insertion line to the control list. 

2. Click the Insert... button. The Insert Object dialog box appears, where you can specify the variation. 

 

Splitting a Course into Two Maps for Map Exchange 

1. Preview off. 

2. Add a second start control (S2) where the map exchange will occur 

3. On the list of controls for that course click between the controls where the map exchange.  

4. Insert the second start. 

5. Click above the new start and click the insert button and select the Map Exchange button in the new 

dialogue box. 

Although in preview it will still appear as one big course it will print as two separate parts 
1. Course > Print > Courses [NOT File Print] 

 

F]  CREATING A NEW CLASS 

To create a new class, you first define its name and assign it to a course.  

1. Choose Classes from Course menu. The dialog box Classes appears. 

2. Unclick “create classes automatically” 

3. Click on Add button to create a new class. A new line is inserted. 
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4. Enter for each class the following information: 

Class: Enter here the class name. Make sure you use the standard form as used in the OASA Course 

Proformas  2006 e.g. W35A  This way the course and class information will import smoothly into the SI 

software. 

Course: Assign the class to a course. 

Runners/teams: Enter here the estimated or actual number of runners. For a relay course enter the number 

of teams. This number is used for the calculation of course statistics. 

Start number: For a relay you have to enter the range of the start numbers. This is necessary for the 

calculation of the the forks and the printout of the course. 

 

G]  PRINTING COURSES  

Select Print….courses from the courses menu to make the Printing Courses dialogue box appear. 

Printer 

Select the printer to print the map. In the box you can select one of the installed Windows printer drivers. 

Click the Properties button to change printing options. 

 

Landscape 

Check this field to print the map in landscape format. 

 

Range 

 

Entire map: Select this option to print the entire map. If the map is too large for one page, it will be printed 

on several pages. 

Partial map: Select this option to print a part of the map. Click Setup to define the partial map to be printed. 

The dialog box Setup Partial Map (Printing) appears. Click the button Entire Map to print the entire map. 

Click the button Current View to print the currently on the screen displayed map. 

 

One page: Select this option to print one page of paper of the map. Click the button Setup to define the 

region to be printed. The dialog box Setup One Page appears. 

Course only on already printed map: Select this option if you want to print courses on existing maps or if 

you want to make printing films for courses. If this is activated, only one page is printed. Click Setup to 

define the region to be printed. The dialog box Course only appears. 

 

Select 

Courses: Choose courses to print the courses. 

Classes: Choose classes to print the classes. You can assign classes to a course in dialog box Classes.  

Select here the courses or classes to be printed. 

You can select a range of courses or classes: 

Click the Select all button to select all courses or classes. 
 

Map scale 

This line shows the scale of the map. Choose Scales from the Options menu to set the map scale. 

 

Print scale 

Enter the scale for the printed map. You can enter the scale on the keyboard, or choose one of the predefined 

scales. If the print scale is different from the map scale, the map and the symbols are enlarged/reduced 

according to the ratio of the 2 scales. 

 

Copies 

Enter the number of copies to be printed. 

 

Options 

Click this button to change printing options (intensity, line width, grid). The dialog box Printing options 

appears. 
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H]  PRINTING CONTROL DESCRIPTIONS Select Print….control descriptions from the courses menu 

The Print Control Descriptions dialog box is now displayed 

Choose this command to print the control descriptions. The Print Control Descriptions dialog box is 

displayed.  

 

Printer 

Select the printer to print the control description. In the box you can select one of the installed Windows 

printer drivers. Click the Properties button to change printing options (for instance to print in landscape 

mode). 

 

Print 

Control descriptions: Select this radio button to print the symbolic control descriptions. 

Text control descriptions: Select this option to print the control descriptions as text. A text must be defined 

for each control. 

 

Box size 

Enter the size of the symbol boxes for the symbolic controls descriptions. Click the Standard button to set 

this value to 6 mm. 

 

Copies 

Enter the number of copies to be printed. 

Hint: If you enter more than 1 copy, OCAD will fill entire pages with the same course until the number of 

copies is reached. Therefore if you enter "2" you will get one page per course filled with as many control 

descriptions as possible of that course. 

 

Select 

Courses: Choose courses to print the control descriptions for courses. 

Classes: Choose classes to print the control descriptions for classes. You can assign classes to a course in 

dialog box Classes.  

Select here the courses or classes to be printed. 

You can select a range of courses or classes: 

Click the Select all button to select all courses or courses. 

 

Hint: You can enter the title for the control descriptions in dialog box Course options in menu Course. 
 

I]   EXPORT COURSES 

Choose this command to export the control numbers and course details. The exported file can then be 

imported to the SI Software. Providing standard class descriptions are used it will match the classes in the SI 

software. 

1. Choose export(XML) from the courses menu. 

2. A file dialog box appears where you can enter a path and filename for the course file. The file will 

have a XML extension. 

Note: if the person setting up the SI software prefers to enter the control numbers & course information 

manually you could choose export courses (text) in 1. above and give them a copy of this. 

 

J]  EXPORT COURSE MAPS 

Use this command if you want to make modifications to courses, which are otherwise not possible. The 

common modifications like moving the control numbers or modifying the connection lines are possible 

without using this command. See Making Modifications for more information. 

Using this command may be dangerous. If you make modifications to the courses after exporting the 

course maps, the exported course maps are not updated and are therefore not correct. Only use this 

command if you are absolutely sure that the courses are final.  

Select 

Select the courses or classes to be exported.  



OSA Policies & Guidelines Section 2.6                       - 6 -                              Course Planning Using OCAD by Ken Thompson          

You can select several courses or classes. 

Click the Select all button to select all courses or classes. 

  

K]   MAKING MODIFICATIONS. 

Often it is necessary to make modifications to the courses generated by OCAD. The common modifications 

made for the different courses are stored in the same file. 

 

Adding a white border to control numbers 

On some maps the control numbers may lack clarity due to large dark areas such as building. This can be 

remedied by adding a white border to the control numbers. Near the top right of the screen look for symbol 

T18. You may need to drag the grey line below this down so you can see it as it is near the bottom In later 

versions (OCAD 12 onwards) there are two symbols in purple near the top ie 31 & 32 (704 Control Number 

& 704.007 All objects code. Right click and choose edit. Go to framing - > Tick line and set a starting width 

of  0.20mm You may want to experiment with this. Then under colour select white background or white on 

yellow. The words & number will vary depending on version of OCAD. Then click OK to save. 

 

Cutting out control circles 

 

If a control circle covers a map detail like a knoll, part of the control circle should be cut out to make the 

knoll visible. You make this cut-out only once for all courses. 

1. Switch off the Preview mode. 

2. Select the Edit point tool. 

3. Select the desired control circle by clicking in its center. 

4. Select the Cut tool to cut out part of the control circle. Left click and drag over part(s) you wish to 

remove. 

Hint: To close (repair) a cut, select the Cut tool and click in the gap.   

 

Modifying connection lines and moving control numbers 

 

You can modify connection lines and move control number in a specific course. 

1. Select the desired course on the right side of the screen. 

2. Make sure that the Preview button is pressed. 

3. Select the Edit point tool. 

4. Select the desired control number or connection line. 

Now you can: 

 - move the control number with the Edit point  tool 

 - cut out part of the connection line using the Cut  tool. Left click and drag over part(s) you wish to remove. 

- insert additional points in the connection line using the Normal point  tool. Move these points using the 

Edit point tool. 

 

Changing the Text Size for Classes within Clue Sheets 

 

Note: This is only an issue with OCAD 9.  In OCAD 11 and later the class box automatically changes size 

to accommodate the number of classes 

 

The Solutions 

A. After you have finished your project in OCAD 9 send the course file to someone who has a later 

version and get them to load it and then save it again as an OCAD file. Problem solved! 

B. Another much more complex solution 

If there a significant number of classes they may print outside of the box limits.. 

Note: To use this extra feature you must have at least version 9.3.9 . Steps 1-5 only need to be done once 

on a computer. 
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   1.  Install version 9.3.9 or higher if you have not already done so. Note: Using the current update on the 

web you can only have one version installed at a time as you have to activate it online. Contact me for 

further information.  

 

   2. Save 40 Add Text for Classes Classes.zip to a known location on your computer (e.g. c:\temp) by 

clicking on the link below 

http://www.ocad.com/howtos/40_Add_Text_for_Classes.zip 

3. Unzip above file which produces a directory called 40_Add_Text_for_Classes containing two files: 

AddTextForClasses.reg and CsExample.ocd The second file can be use for practising using these 
instructions. 

4. Double left click AddTextForClasses.reg to make the necessary changes in your computers registry. 

5. Open your OCAD course planning project or CsExample.ocd if you just want to practise. 

6. Make sure preview is not selected. 

7.  Scroll down OCAD objects (You can drag grey line at bottom of box to enlarge it while you do this) 

until you find 17.3 T10 (Control description Title). Select by left clicking. 

8. Right click and select duplicate. 

9. Select the duplicate that should be the one to the right (17.8) 

10. Right click and select edit. 

11. Change description to read Control descriptions: Classes 

12. Change Point size to a smaller value. e.g. 6pts 

13. Press OK 

14. Drag box back to normal size if you had dragged it down. 

15. Select a course that was causing a problem and preview to check. 

16. Make yourself a strong cup of coffee. You are finished! 

 

If the above was a bit hard to follow the OCAD crew have prepared an excellent how to flash video that you 
can watch by clicking on the link below: 

Flash Video Link: http://www.ocad.com/howtos/40.htm 

 

Making other modifications 

 

If you want to make other modifications than those described here, choose Export course maps from the 

Course menu. In the exported maps you can make any modifications. A number of other useful flash videos 

on the use of OCAD can be found at: 

www.ocad.com/en/howtos.htm  
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